 HDR (High Dynamic range) using Google Nik HDR Efex Pro for tone-mapping

What is HDR
HDR is an acronym for High Dynamic Range where dynamic range is the ratio of light to dark in a photograph. By using special HDR software, you can see all the light in the final photo that you saw when you were standing on the scene. The human eye can see so much more than a single camera shot since an eye can see about 11 stops of light whereas a camera can only see about 3 stops of light.

Instead of just taking one photo, HDR uses three or more photos (bracketed images), taken at different shutter speeds. You can then use image editing software which dramatically increases the dynamic range of a photograph by merging different exposures of a same scene.

HDR technique has had some very bad rap, especially in the "fine art" community, due to heavy saturation of colors, strong haloes, high contrast between edges and unrealistic/painterly appearance (sometimes called “HDR Look”). The unrealistic look is cause by pushing the tone-mapping and adjusting the detail algorithms to their limits. However, this technique can be very powerful, look perfectly natural and sometimes it is the only way to capture a scene as our eyes see it.

When HDR software initially processes the images, the result can look grungy, artificial and unrealistic. It is important to remember you should never try to obtain the final look of an image in the tone mapping phase, and instead just focus on bringing all the details back from shadows and highlights. Keep contrast low (especially local contrast) and do not add saturation to the image at this stage.

When to use HDR:
• Landscapes: Landscape photos usually have a lot of contrast between the sky and land, which is difficult for your camera to deal with in just one photo. With HDR, you can capture the sky's detail without making the land look too dark, and vice versa. Try to keep an eye out for scenes and subjects that have a large, noticeable contrast between light and dark areas to be able to capture all the full dynamic range.
• Portraits in Sunlight: Lighting is one of the most important aspects of a good photo, but too much lighting on someone's face—like harsh sunlight—can cause dark shadows, bright glare, and other unflattering characteristics. HDR can even that all out and make your subject look better.
• **Low-Light and Backlit Scenes**: If your photo is looking a little too dark—which often happens if your scene has too much backlight—HDR can brighten up the foreground without washing out the well-lit portions of your photo.

**When not to use HDR:**

• **Photos with Movement**: If any of your subjects are moving (or might move), HDR increases the chance of a blurry photo. Remember, HDR takes at least three photos, so if you’re subject moves between the first and last shot, your final picture won't look good. However, some software will allow you to get rid of ghosting or movement by selecting an individual photo and disregarding the moving object.

• **High-Contrast Scenes**: Some photos look better with stark contrast occurs between dark and light parts of the photo. HDR will make this less intense, resulting in a less interesting photo. However, post processing can help resolve this issue.

• **Vivid Colors**: If your scene is too dark or too light, HDR can bring some of the color back. However, if you’re dealing with colors that are already very vivid, HDR can wash vivid colors out.

• If you can easily blend an image using a **Graduated Neutral Density (GND) filter** then HDR may not be a suitable option. These types of filters can extend dynamic range while still maintaining local contrast. GND filters are best suited when shooting darker land with a very bright sky in landscape photography.

**Equipment/Software needed:**

- **A camera**: If you want to become a better photographer you need to be proficient with all the camera’s features. Spend time reviewing the camera’s manual. Understand the camera’s Auto Exposure Bracketing (AEB) mode (sometimes called “Auto-Exposure Mode” or “Exposure Bracketing) which is the main component in creating HDR images. Bracketing is the term used to describe taking multiple exposures to capture the full spectrum of light in a scene. When you select AEB mode, the camera automatically takes three or more shots with a different exposure for each frame. AEB isn’t necessary, but without it you’ll have to adjust your camera’s exposure manually between each shot, which may increases the chances that your camera will move and increase the likelihood that parts of the scene will move. If your pictures don’t line up, the final HDR image will most likely be unacceptable.

Metering is one of the more complicated settings on your camera, and one that you need to thoroughly understand. The metering mode is simply how your camera samples light to determine the proper exposure for the image. The camera needs to analyze the light in the scene using different exposure methods. Evaluative Metering generally is your best option. Other metering modes include partial, spot, and center weighted metering. Each mode should be used when required for the scene and can drastically improve your image if you use the proper mode.

- **Lens choice**: You can capture High Dynamic Range images with any lens--telephoto, macro. But by far, ultrawide angle lenses are best for a number of reasons. These lenses take in broad, sweeping angles of view and allow for close focusing to really showcase foreground elements. You can achieve great depth of field, even at medium apertures. Due to the expansive angle of view, you’ve got to be aware of **Keystoning** (Tops of buildings look like they are leaning backwards due to the tilting up of the camera leading to this effect. If the camera is level, then perspective distortion doesn’t occur). When shooting up at a building, make sure the top and bottom windowsills are parallel with the top and bottom of the sensor. Some photographers believe that a 24-70mm lens is the best choice.

- **Tripod**: Since you will be bracketing, you will want to stay as stable as possible between shots. It’s imperative to have a steady platform so all the shots aligned. HDR software generally has a feature which attempts to align the images when the camera has moved between shots, however, the best results are achieved when this feature is not relied upon. Also make sure you have a **good tripod head**.

- **Remote Release**: If you have a remote release for your camera, use it. You can also use the short self-timer. In order to boost the quality of your photographs use a delay for Mirror Lock-Up before every picture is taken. Locking the mirror before taking a picture gives a tripod-based camera the ultimate stability required to take a perfectly sharp photograph. If your camera has automatic exposure bracketing, then use it (this is called AEB on the menus on Canon cameras). Setting AEB to -2/+2 EV is generally a good options but must be increased for high contrast scenes.
- **Triggertrap Mobile**: Triggertrap Mobile utilizes the sensors and processing power of a smartphone or tablet to trigger cameras based on sound (clap, honk etc.), motion, vibration, or location. The app allows for time lapse photography, Bulb Ramping, HDR bracketing and other features. The camera is connected to the smartphone or tablet using the Triggertrap Mobile Dongle (camera specific). The apps are free and available both for iPhone and Android.

- **Promote® Control**: Promote Control is a remote control device for digital SLR cameras. The Control allows for advanced control of camera functions via USB interface and can accomplish automatic bracketing for up to 45 shots in a row and up to 9.0EV steps between bracketed exposures. By default, the Promote Control takes a "middle" shutter speed as a start, and then takes a number of pictures with the shutter speed stepped under and over the "middle" exposure.

- **Tone-mapping (HDR) Software**: The three most popular HDR software programs are Photomatix (the most popular @ $99), HDR Efex Pro (bundle $149), and Adobe Photoshop. Photomatix is a slider and button-based interface that is a lot less intimidating and more intuitive than the Adobe Photoshop interface. Adobe Photoshop has several downsides including the overall level of control but can process a very natural looking HDR image from a bracketed sequence. Google Nik HDR Efex Pro 2 enables you to create exceptional natural and artistic images. The company’s patented U Point® technology enables precise, selective fine-tuning, simplifying and speeding up the process for creating high dynamic range images. NOTE: HDR Efex Pro is not a stand-alone program and is not compatible with Adobe Photoshop Elements. Photomatix and Adobe Photoshop are stand-alone programs. If you are looking for a free option then Luminance HDR is recommended and is a very capable HDR program. Many professional photographers provide HDR software discounts on their web sites of about 10%. Most of the HDR software companies provide a 30-day free-trial period and it is recommended you try each before buying.

**Taking HDR photos:**

- **Mount your camera on a steady tripod.** It’s highly recommended to use a Tripod in order to achieve the highest quality to ensure that the camera does not move as each image is captured. If it is not possible to use a tripod, the camera should be steadied as much as possible. This can be done by leaning against a tree or a wall, or steadying the camera on top of a rock or railing.

- **Set your camera to shoot in raw and set everything to Manual.** Do not set the camera’s white balance to AWB, set the conditions to sunny, cloudy, etc. Use manual exposure mode and select an appropriate aperture for your scene and the lowest ISO setting possible (100 ISO if possible). Turn off your flash. Always keep the aperture the same between the shots, so Aperture Priority mode is appropriate. You do not want to have images with different depths of field; therefore set Manual Focus. It is very important to understand Depth-of Field (DOF), Hyperfocal Distance (HFD) and how to determine the “sweet point” of your lens (2-3 stops down from maximum aperture). When using a Tripod, set Image Stabilization to OFF.

- **Normally you should not use filters:** The one filter that can be used for HDR images is a solid neutral density filter, which is used to get longer exposure times in bright conditions to help blur moving subject(s), like water. Recommended filter is “Singh-Ray Vari-ND,” which allows you to control the degree of darkness by rotating it.

- **Composition is critical.** For Landscape photos consider the following:
  - An off-center subject encourages the eye to move around the scene. Try looking for a single dominant element that can be placed in the frame according to the rule-of-thirds (grid division into even thirds) or the Golden Ratio rule (62/38 division with the intersection if important diagonals). Finding the right viewpoint is very important to achieve a successful landscape composition. Rather than shooting everything from head height, try shooting from high and low viewpoints and move right and left of the dominant feature.
  - Lead-in lines can improve the impact of and add depth to your photos. Although lead-in lines come in many forms, some natural, others man-made, all of them tend to either lead the viewer in or out of the photo or toward a focal point. Some of the most effective lead-in lines start from the bottom edge of the frame and go straight in to center of the photo.
- If you want to capture the drama of a great scene, you need to move in close and make the most of the foreground — it's one of the important elements you need to create a dynamic composition. Emphasizing the foreground will help to give your photographs a sense of distance and scale. Images lacking foreground interest can look flat and boring. Features close to the camera look much bigger than those further away. Foreground also provides a convenient entry point into the composition for the viewer’s eye which then naturally travels up through the scene to the focal point. By placing the camera in a vertical position, more emphasis can be placed on foreground subjects. Foreground interest shouldn’t dominate the composition or be included for the sake of it. — it should complement the view, creating depth.

- **To photograph a high contrast scene**, you need to take several exposures in order to capture information in both the highlights and the shadows of the scene. The exposures taken must properly cover the dynamic range of the scene, especially the shadows to help prevent noise when processing the photos. To determine the exposures requirement, first set your camera metering to Matrix (Nikon) or Evaluative (Canon) to let the camera pick the best exposure for the whole scene. Review your Histogram and try to get the histogram curve as close to the right side as possible (just touching) and check for any highlight clipping. When satisfied with the exposure, note the settings as this will be your middle exposure setting you will use in Manual mode.

- **Setting Exposure Value (EV)**: If you use one-EV steps (e.g., -1, 0, +1 EV), you will need more photos than if you take them in two-EV steps (e.g., -2, 0, +2 EV). It’s recommend shooting in two-EV steps whenever possible. However, sometimes a 1.5EV spacing vs. 2-EV will give you a smoother tonal gradation. An example of one-stop bracket: -½-sec, 1-sec, +2-sec; two stop bracket (preferred): -¼-sec, 1-sec, +4-sec; three stop bracket: -1/8-sec, 1-sec, +8-sec. The **full spectrum of exposure stops in minutes and seconds**: 4-min, 2-min, 60-sec, 30-sec, 15, 8, 4, 2, 1-sec, ½, ¼, 1/8, 1/15, 1/60, 1/125, 1/250, 1/500, 1/1000, 1/2000-sec and etc.

- **High contrast scenes** can be grouped into roughly two types depending on their dynamic range:
  - **Medium dynamic range scene**: Most landscapes and other types of outdoor scenes fall into this category. Three exposures taken in two-EV steps (-2, 0 +2 EV), or five exposures taken in one-EV steps, are usually sufficient for this type of scene.
  - **High dynamic range scene**: A typical example is the interior of a room with a view outside the window on a sunny day. You need to take at least five exposures in two-EV steps (or nine exposures in one-EV steps) to capture this type of scene, but you may need more.

  **Shooting directly into the Sun**, you will need to use a very wide bracket sequence, normally ±4 sequence to get a good HDR image. If you center the lens on the sun, lens flare and ghosting will be minimized. Flare is nearly impossible to remove from you images, and it can get strongly accentuated during tone-mapping.

  Most digital cameras offer **Automatic Exposure Bracketing (AEB)**. This enables you to automatically take three or more exposures in a row; one at the proper exposure, one or more underexposed, and one or more overexposed. Consult your camera manual for model-specific instructions for using this setting. Use your camera’s AEB function but only if it allows sufficient exposure increments and number of auto-bracketed frames to cover the dynamic range. Otherwise, you will have to vary the exposure times manually or use a Promote® Control or Triggertrap Mobile device.

  **Shoot frames as quickly** as you can while keeping the camera steady. Watch out for moving objects such as clouds, people or wind moving foliage. Although Photomatix Pro has a built-in function to reduce ghosting artifacts, it is still best if movements are minimal — motion is sometimes difficult to fix in software.

  **Review your photos**: Use your camera's histogram preview in playback mode. When reviewing the most overexposed photo, the left part (2/3) of the histogram should be empty. Then review the darkest image histogram, the right part of the histogram (1/2) should be completely empty. If the highlight/shadow photos are not correctly exposed, you will need to add another bracket which will require reshooting the sequence.

**Things to avoid:**

- **Ghosts**: Whenever some element in your composition moves between frames, there is a good chance that it will show as a ghost figure, since the tone mapping algorithm will mix a little bit of each image to reach its final
result. Software can normally handle ghosting, but it still can be a major problem. Vegetation blowing such as leaves will be nearly impossible to process. HDR is mainly a technique for static subjects.

- **Noise:** HDR processing will generally increase noise, especially in the shadow areas. Use as low an ISO as possible. The best way to reduce noise in a photo is a noise reduction plugin like Topaz DeNoise.

- **Excessive saturation:** Generally speaking, saturation applied by the tone mapping software will give the toned mapped image an artificial look. Use minimal saturation adjustments in the tone-mapping software. You can fix saturation in post processing either in Photoshop or Lightroom.

- **Excessive contrast:** During the tone mapping process you must decide when contrast is excessive. Try and recall how the scene looked and make adjustments accordingly in the tone-mapping software. If you can’t recall the scene, then make sure the image looks natural, not artificial.

- **Halos:** Whenever dark and a bright areas meet in the image (i.e., edges been mountains and sky) most likely you will have a Halo as a result of tone mapping. A Halo is a white glow around high contrast areas. You can reduce Halos by reducing micro-contrast in the tone-mapping software. However, the best way to avoid halos in a photograph is to apply minimal tone-mapping. When you tone map an image, always keep an eye for halos and process the images in such a way that halos do not form.

### Initial Processing of HDR Sequence Images in Lightroom

As in setting up the camera for HDR, you need to treat your image sequence as though it were a single exposure. The same is true for post-processing all the images. **Any adjustments made to an image must be applied to all other images in the sequence.** Be sure to calibrate your monitor before post-processing.

- **Review images:** Review each image and determine if the histogram for the brightest and darkest images are not completely off the ends

- **White Balance:** Although you can make color temperature corrections in the HDR software, it’s best to get the white balance setting correct up-front.

- **Tone Curve and Color Setting:** The goal is to create a set of relatively low-contrast, low-saturation images that are sharp when viewed at 1:1 magnification. Do not make any Basic settings. Set all settings to zero and it’s particularly important to set the Blacks setting to zero. The Parametric and Point Curves should be linear (flat).

- **Sharpening Settings:** Generally, you get best results by pre-sharpening RAW files to the point where small details are discernible but halos are not. However, it is suggested NOT TO SHAPREN to avoid introducing unwanted artifacts & noise.

- **Chromatic Aberration Removal:** Under Lens Correction tab select Basic > Enable Profile Correction and then enable Remove Chromatic Aberration. Chromatic aberrations can be removed within the RAW conversion utility of Lightroom, as Lightroom utilizes lens data tailored to the chromatic aberration reduction for your camera and lens combination.

- **Details:** Set the Sharpening amount to zero.

- **Dust Removal:** Dust spots create headaches in HDR images. It’s best to remove spots prior to conversion but can be removed later in post processing. If you drag the black and white point sliders towards the center of the histogram, doing so will reveal dust spots, which can be removed using the spot removal tool. After locating and removing spots, reset the level tool to its default state (linear [flat] tone curve).

- **Synchronize adjustments:** It’s critical that all images are identical with the exception of exposure. Highlight all the photos and depress the SYNC button.
Google Nik — HDR Efex Pro

After adjusting your photos in Lightroom as described above, import them into HDR Efex Pro. Select all the photos and then right-click on one of the images and select **Edit > HDR Efex Pro**.

The **Merge Dialog interface** will appear and will show a preview of each sequence of images to be merged:

![Merge Dialog Interface](image)

It’s here that you fine-tune your image merge. Start by checking that all images are present and they look correct.

- **Alignment**: To overcome alignment issues, select the Alignment check box. Check this box to reduce any potential alignment artifacts. The software will automatically crop the image to remove areas with only partial image information.

- **Ghost Reduction**: Once you’ve checked the checkbox, a Ghost Reference Image selector will appear over one of the images in the Filmstrip at the top of the Merge dialog. The image selected in Ghost Reference Image selector will act as the basis for the ghost reduction algorithm, with the goal of making all of the moving objects appear as they did within the reference image. Use the Strength control to adjust the ghost reduction effect. The default strength of 100% is recommended for most image series. If ghost artifacts are still present in your image, try selecting another image using the Ghost Reference selector by either clicking on the target image or by clicking and dragging the Ghost Reference selector and moving it onto the appropriate image.

- **Chromatic aberrations**: This helps reduce aberrations that become visible as color fringes around an object. Chromatic aberrations are most often visible as colorful fringes around objects in your images, especially around high contrast edges. The Red-Cyan and Blue-Yellow sliders enable you to remove any chromatic aberrations from the image series. In order to best see the chromatic aberrations, open the Loupe tool and ensure that the Chromatic Aberration option is selected at the top of the Loupe. Adjust the position of the Loupe until you can best review the chromatic aberrations in your image. Chromatic aberrations are easiest to see at the corners of the image, especially with high contrast edges, such as tree branches on top of a blue sky. Each slider will attempt to remove the most common types of chromatic aberrations: green or magenta chromatic aberrations, or blue or red chromatic aberrations. Move each slider until the color fringes are no longer visible.
By depressing the **Create HDR** button the images in the series will be merged into a single HDR image and enable you to begin tone mapping your image.

**HDR Efex Main Interface**

The main interface is used to adjust your images and is divided into three sections/panels. The Left Panel contains the Preset Library and History Browser. The Image Preview window is located in the center. The Right Panel contains all the image adjustment control.

**Image Comparison Tools (top left):** You can toggle the Preview Window to show before/after comparisons of your image adjustment in three modes: Single Image, Split Preview, and Side by-Side Preview. The default is between the original (default) image and current view. Use the History Browser to select different before & after adjustment points.

**Settings Button (bottom left):** You can change Interface, Alignment/Ghost, Software update, GPU, Output & Stacking settings. Use the GPU checkbox to enable/disable your computer’s graphics card. Disabling this option will slow down the application. Output Settings specifies the file type (JPEC or TIFF) and compression settings for file produced using Lightroom. You get the highest quality output by selecting “TIFF 16.”

**Save/OK and Cancel Buttons (bottom right):** The Save button allows you to exit and save the changes to your tone-mapped file. The Cancel button is used to exit without saving.

**Color Space Setting:** Use large color space, like ProPhoto RGB or Adobe RGB, when editing images. This software uses the color space setting specified by your host application (Lightroom). For Lightroom set the color space from the “Export” preferences for HDR Efex Pro 2 (File > Export >Google > HDR Efes Pro 2).

**Right Panel Controls:** Contains image adjustment tools that are subdivided into the following subpanels:

**Working with Control Sliders:** Sliders can reset to default
values by double-clicking the slider button as well as directly entering numerical values

**Loup & Histogram Window:** In the bottom-right corner find display. The Loupe tool display a 1:1 magnification preview of your image.

The **Histogram** is a graphical representation of the distribution of tones in the image. It lets you objectively evaluate the image brightness and contrast. The x-axis runs from 0 to 255 (black to pure white). The center is neutral (mid-tones). The height of the curve represent the number of pixels in the image that have a particular tone value. The two small boxes in the histogram window are clipping warning displays. When you hover over the boxes, clipped tones appear in a color overlay in the Preview window.

**Left Panel Controls:**

- **Preset Library:** By default, the Preset Library will display in the left panel.
- **Custom Presets Panel:** If you create a custom HDR presets, they will be stored and are exported and shared.
- **Imported Preset Panel:** When you load custom presets.
- **History Browser Panel:** Shows a sequential list of every adjustment or editing steps done. It is a way to undo your editing steps. The History panel is a chronological list of all adjustment. Clicking on a state will immediately revert your photo back to the previous setting. You may either click on another state to revert your photo to another state. Adjusting the filter settings after reverting back to a previous state will permanently erase any subsequent steps. Switching to the Split or Side-by-side preview modes or clicking on the Compare button shows the History State selector. Once the Compare slider has been activated, you will be able to view your image in several different states. Default Tone Mapping and Middle Exposure will be available for comparison.
  - **Merge Setting Button:** Under the History Broser tab is the Merge Settings button which will return you to the Merge Setting window that first displayed when you opened the Nik software. Top of the History Browser, you’ll find a button labeled “Merge Settings.” Sometime, you may find ghosting artifacts after you already merged your images. Use this button to go back, amend your setting and then return to Main Interface without having to reload your image sequence. When you return to the Main Interface, all your adjustments will remain intact.
  - **Default Tone Mapping:** Selecting this history state will allow you to compare the current enhancement with the original tone mapped image without any adjustments.
  - **Middle Exposure:** Selecting this history state will allow you to compare the current enhancement with the middle exposure of the image series, without any tone mapping applied. By comparing with the middle exposure, you can compare the HDR image with one of the original non-HDR images from the series.
  - **Last Filtered State:** This button is located at the bottom of the History browser and works like a preset using the exact adjustment used on your last image.

**Image Adjustment Controls:**

- **Tone Compression Panel:** These controls are the core creative tools. The tools set baseline style ranging from very clean to extremely surreal or textured. This panel should be used first, then it is relatively easy to fine-tune the image with the other panels.

- **Tone Compression Slider:** This sets the overall dynamic range and contrast in your image. Moving slider to the right increase compression and reduces contrast (Dark and light tones are all squeezed together towards the center of the histogram — middle-toned). Moving the slider to the left expands the tone range which creates more contrast and will potentially clip dark or light tones. As compression increases, the images will look less natural.
**Method Strength:** Controls the amount of Drama and Detail that is applied to an image. This allows you specific fine tuning over the style of tone mapping algorithms that are applied to your image. For even more fine tuning adjustments, this is also a slider within the Control Points, for localized adjustment of the range.

- **Depth Control:** This control helps create a sense of depth or dimensionality in your HDR photos. As HDR tone mapping can often render images flat and lacking in the visual cues of a three dimensional image, the Depth slider can add some of that dimensionality back into the image to create a more natural looking photograph. This control enhances dark tones (shadows) in a way that creates the illusion of depth. The use of this control can lead to dark halos in blue skies. There are three options: Subtle, Normal, and Strong.

- **Detail Control:** The Detail control adjusts the tone mapping algorithms within HDR Efex Pro 2 to provide more control over the way fine details are rendered. Since fine details are affected most, zoom into 100% to determine the appropriate option. It is similar to an edge-sharpening tool. There are five slider options: Soft, Realistic, Accentuated, Detailed and Grungy. Realistic and Accentuated provide the most natural-looking enhancements.

- **Drama Control:** Adjusts the style of the tone mapping effect. The Drama algorithm identifies different areas of an image based on tonality and colors, working to accentuate contrast in those areas. Moving this slider to the right alters the style from more natural results to more creative and stylistic results. The six presets are: Flat, Natural, Deep, Dingy, Sharp, and Grainy.

**Tonality Panel:** Used to adjust and enhance the overall brightness and contrast in your image. The adjustments are made to entire image. You should have the histogram open when making adjustments.

- **Exposure Slider:** controls the overall image brightness. To increase move right. The entire histogram shifts left or right.

- **Shadows & Highlights Sliders:** These sliders let you adjust the upper and lower 1/3 of image tone range. Shadows slider controls the dark tones – moving right opens up shadow areas and left darkens shadows. The Highlights slider affects the brightest tones.

- **Contrast Slider:** This controls the global contrast in the image. Move left to recover highlights; move right to brighten them.

- **Blacks & Whites Sliders:** These sliders operate on the tone values at the very ends of the histogram

- **Structure Slider:** A special form of contrast, called “local” or “micro” contrast. This tool produces an effect similar to large-radius high-pass sharpening. When you move slider to the right, local contrast (texture) in the entire image is accentuated. Keep values to a minimum so that the image looks realistic. Exaggerating Structure can make your images look harsh. This feature also is used to smooth out images and reduce local contrast artifacts (halos). If you move the slider to the left, contrast is diminished. The tool can reduce local contrast artifacts (halos).

**NOTE:** Red highlight indicates that these adjustments are the most important.

**Color Panel:** The three sliders control different aspects of colors.

- **Saturation Slider:** controls the overall intensity of colors. Move it to right to increase colors.

- **Temperature Slider:** controls the orange/blue hue in the image. Use this control to refine the white balance. Move right to make image warmer (orange) and move it left to make image cooler (blue).
• **Tint Slider:** this shifts the hue of the image along a green-magenta axis. This can be helpful when trying to correct color casts from artificial light sources. Move right to add magenta hue and left to add green.

**Selective Adjustment Panel (Control Points):**

Selective Adjustments, sometime called local adjustments, are enhancements applied to specific areas of the image. Nik Software uses Control Points for selective adjustments. This feature allows you to enhance or diminish an area.

- **Adding a Control Point:** To add a Control Point to the image, expand the Selective Adjustment panel and click the “Control Points” button. Then click anywhere on the image. You will see a Control Point (dot with sliders). Click the triangle in the slider list to expand all the controls. If you check the “show mask” box next to any Control Point in the panel you will see the selected area. When in view mask mode, the image preview turns to black and white. White areas indicated the part that is select, while dark areas are protected. Gray areas are lower opacity than white areas, which helps make selection created appear to be very natural. The first control slider is the Size slider and when you click it, you’ll see a circle appear. The area inside the circle approximates the area under influence. The selection extends beyond the circle boundary but the opacity of the selection decreases as it get farther from the center. Using multiple Control Points gives you the ability to crate complex selection masks. By default, the Control Point sliders are set at zero, causing selected area to revert to its original state.

- **Duplicating Control Points:** Button found next to the Trash Can. You can make copies of the active Control Point by using the “Duplicate” button after you click the Control Point you want to copy. You can also hold down the Alt key and then click and drag an active Control Point.

- **Adjusting Multiple Control Points Simultaneously:** SHIFT-click on each Control Point you wish to select OR shift-click on multiple Control Point in the Control Point List to select them. Once the Control points are linked, you can adjust them synchronously by moving any control slider at any point. To deselect the points, click anywhere on the preview window.

- **Grouping Control Points:** Select two or more Control Points and then click the “Group” button (bottom left). When the group is created, you will see only one button

- **Deleting Control Points:** Click on the control point and then, click the delete (trash) button. To delete an entire group, first click the Master Control Point. Then, click the Master Control Point a second time. This will select all the Control Points; then use the delete button.

**Applying Selective Adjustment with Control Points:** Adjustments are applied to the circle area only:

- **Selective Color and Contrast:** Most of the time, you can use the Exposure, Contrast, and Saturation sliders to balance out tones and colors in your image. By increasing local exposure (brightness), contrast, and saturation, the viewer’s eye will be drawn toward that area.

- **Selective Structure:** The global Structure slider creates a local contrast affect similar to large-radius high-pass sharpening. However, it can be easily overdone, especially if an image contains a sky. Normally should leave the Structure slider set to a low value (0-10%) and then simply use Control points to add texture to rocks, clouds, and other objects.

- **Negative Structure Adjustments:** Unlike traditional high-pass sharpening, which can only add texture, you can smooth images with the Structure slider by applying a negative number. Use this effect to smooth out skies, water, or anything else that contains potentially distracting or unnatural textures.
- **Selective Temperature and Tint Control**: If your image contains a blue sky and parts that are in the shade, then by placing a Control Point on the shady area and make a temperature adjustment to the warm side, the sky can remain daylight temperature. Also you can combine the Tint slider with the Temperature slider to modify local color balance or remove color casts.

**Exposure (Ex)** – Changes the Exposure Value of the image. Moving this slider to the left darkens the image while moving to the right increases the brightness of the image.

**Contrast (Co)** – Controls the overall contrast of the image.

**Saturation (Sa)** – Controls the overall saturation or intensity of color in the image.

**Structure (St)** – Controls the overall structure of the image. Increasing this slider emphasizes fine details while decreasing this slider reduces the appearance of fine details for smoother surfaces.

**Blacks (Bk)** - Increases the amount of black in the image. Helps to provide rich dark tones or depth to an image as well as to ensure the presence of blacks within the image.

**Whites (Wh)** - Adjusts the white point of the image. Moving this slider to the right will brighten the white point, causing light objects to become lighter. Moving this slider to the left will darken the white point, darkening light objects.

**Temperature (Te)** – Moving this slider to the left will cool the selected area by introducing blues while moving the slider to the right will warm the selected area by introducing oranges

**Tint (Ti)** – Moving this slider to the left will make the selected object more green while moving the slider to the right will make the selected object more magenta.

**Method Strength (MS)** – Moving this slider to the left will decrease the amount of Drama and Detail that is applied to the tone mapping algorithm affecting the selected area. Moving this slider to the right will increase the amount of Drama and Detail that affects the tone mapping of the selected area.

**Tips:**

1. After clicking on a slider, use the left and right arrow keys to increase or decrease the slider values incrementally. Use the up and down keys to cycle between the different sliders. Use the “E” key to expand and collapse the control point sliders.

2. The use of the selective tool is an excellent way to reduce Halos. Use a small circle over the Halo and reduce the Method Strength. Depress the Duplicate key (bottom right icon) and quickly apply the same affect amount as you work along the Halo edge.

**Finishing Adjustments Panel**: There are three basic Finishing Adjustments:

- **Vignette**: Used to darken or lighten the edges of you image to create “burn/dodge” effects. You can choose to lighten or darken the images borders for a creative effect. It tends to draw the viewer’s eye towards the center of the image. There are eight Vignette presets to choose from:

- **Graduated Neutral Density Filter**: This tool is used to darken or lighten the entire image along a gradient; similar to a traditional ND grad filter. Controls for the tool can be displayed by clicking on the triangle next its name in the Finishing Adjustment pane. The controls are as follows:
  - Upper Tonality: Controls the brightness at the upper portion of the gradient.
  - Lower Tonality: Controls the brightness at the bottom portion of the gradient
- Blend Slider: Adjusts the softness of the gradient edge.
- Vertical Shift: Moves the filter effect up or down in the image.
- Rotation: Rotates the filter effect.

*The recommended steps to position the ND filter:*
- Set the Upper Tonality slider to -3 stops.
- Set the Blend slider to 0. This setting creates a readily visible edge boundary.
- Position the filter effect with the Vertical Shift &/or Rotation sliders.
- Adjust the Upper Tonality and Lower Tonality to suit your image.
- Adjust the Blend slider as necessary.

- **Levels and Curves:** Traditional tool for adjusting image brightness and contrast. You can select the following presets: Neutral, Film (EV-1), Film (EV+0), Film (EV+1), Dark Contrast, Bright Contrast, Vintage 1, 2, & 3.

**Recommended HDR Efex Pro steps for Tone-Mapping:**
- Merge your files.
- Adjust Global Brightness with the Exposure Slider.
- Adjust HDR Method Control & Method Strength.
- Adjust Tone Compression settings.
- Adjust Global Contrast.
- Fine-tune Exposure and Contrast.
- Adjust Color Controls.
- Adjust Global Structure.
- Make Local Adjustment with Control Point.
- Apply Finishing Effect.

**Black & White HDR photos:** There are three ways to create a Black & White photo:
- Desaturate the photo in Photomatix Pro by setting the Saturation slider to 0. If you use Details Enhancer you have to set the processing methods to a minimum value (-10) and set that both Saturation Highlights and Saturation Shadows to 0.
- Convert the photo to grayscale in Photoshop. For the best B&W spectrum you should select New Adjustment Layer > Gradient Map. Then on the Gradient Map Properties dialog box depress the down arrow next to the gradient box and select the third gradient from the left on the top row labeled Black, White. This techniques will give you the most contrast and “punch” between B&W.
- Use plugins such a Nik Silver Efex Pro or Topaz BW Effects. Both these plugins do an excellent job.
Creating HDR Panoramas:

- When creating HDR panoramas, it's best to use your HDR software to tone map each panoramic image scene first before stitching into a panorama. It is highly recommended to use identical tonemapping adjustments to each scene.

  If you are using Photomatix to tonemap your images, then make the necessary adjustments to your first scene. Next save those adjustment settings as a Preset. When you tonemap the other scenes, apply the Preset to each HDR scene. To expedite the processing, you should use Photomatix Batch Processing where you select all the remaining scene images and Photomatix will process each scene and save the each scene as a HDR image.

- Next stitch each HDR series photos using Photoshop by selecting File > Automate. The Photomerge dialog box will display, then click on the Browse button and select your HDR photos. Next check Blend Images Together and if needed check Geometric Distortion Correction. Depress OK and Photoshop will stitch each scene together into a panoramic photo. Photomerge will also correct for exposure difference between scenes. You may see a small line where each layer is stitched. The lines will disappear when you flatten the image.

- Most likely you will have transparency along the edges; therefore, you need to either crop the panoramic image or use Content Aware (make selection, then Edit >Fill >Content Aware).

- Finally, flatten all the layers so you make adjustments in Photoshop.

Post Processing:

After tone-mapping in Photomatix you basically get only a rough draft that can look dull or have the “HDR” look characterized by over saturated colors, strong “haloing” along high contrast edges, and a surreal look. Post processing is a necessary and very important step to correct these errors and fine tune your image. Sometimes portions of the HDR stitched photo are not appealing and these areas can be corrected by blending an original stitched photo using software such as Photoshop and Elements.

You can find a post-processing tutorial on the Redlands Camera Club website which covers many techniques for post-processing HDR images using Adobe Photoshop.

This article was prepared by John Williams for the benefit of Redlands Camera Club members (for instructional purposes only).
What is HDR?
HDR is an acronym for **High Dynamic Range** where dynamic range is the ratio of light to dark in a photograph. By using special HDR software, you can see all the light in the final photo that you saw when you were standing on the scene. The human eye can see so much more than a single camera shot since an eye can see about 11 stops of light whereas a camera can only see about 3 stops of light.

Instead of just taking one photo, HDR uses three or more photos (bracketed images), taken at different shutter speeds. You can then use image editing software which dramatically increases the dynamic range of a photograph by merging different exposures of a same scene.

HDR technique has had some very bad rap, especially in the "fine art" community, due to heavy saturation of colors, strong haloes, high contrast between edges and unrealistic/painterly appearance (sometimes called “HDR Look”). The unrealistic look is cause by pushing the tone-mapping and adjusting the detail algorithms to their limits. However, this technique can be very powerful, look perfectly natural and sometimes it is the only way to capture a scene as our eyes see it.

When HDR software initially processes the images, the result can look grungy, artificial and unrealistic. It is important to remember you should never try to obtain the final look of an image in the tone mapping phase, and instead just focus on bringing all the details back from shadows and highlights. Keep contrast low (especially local contrast) and do not add saturation to the image at this stage.

When to use HDR:
- **Landsapes**: Landscape photos usually have a lot of contrast between the sky and land, which is difficult for your camera to deal with in just one photo. With HDR, you can capture the sky’s detail without making the land look too dark, and vice versa. Try to keep an eye out for scenes and subjects that have a large, noticeable contrast between light and dark areas to be able to capture all the full dynamic range.
- **Portraits in Sunlight**: Lighting is one of the most important aspects of a good photo, but too much lighting on someone’s face—like harsh sunlight—can cause dark shadows, bright glare, and other unflattering characteristics. HDR can even that all out and make your subject look better.
- **Low-Light and Backlit Scenes**: If your photo is looking a little too dark—which often happens if your scene has too much backlight—HDR can brighten up the foreground without washing out the well-lit portions of your photo.
When not to use HDR:

- **Photos with Movement**: If any of your subjects are moving (or might move), HDR increases the chance of a blurry photo. Remember, HDR takes at least three photos, so if you’re subject moves between the first and last shot, your final picture won’t look good. However, some software will allow you to get rid of ghosting or movement by selecting an individual photo and disregarding the moving object.

- **High-Contrast Scenes**: Some photos look better with stark contrast occurs between dark and light parts of the photo. HDR will make this less intense, resulting in a less interesting photo. However, post processing can help resolve this issue.

- **Vivid Colors**: If your scene is too dark or too light, HDR can bring some of the color back. However, if you're dealing with colors that are already very vivid, HDR can wash vivid colors out.

- **If you can easily blend an image using a Graduated Neutral Density (GND) filter then HDR may not be a suitable option.** These types of filters can extend dynamic range while still maintaining local contrast. GND filters are best suited when shooting darker land with a very bright sky in landscape photography:

**Equipment/Software needed:**

- **A camera**: If you want to become a better photographer you need to be proficient with all the camera’s features. Spend time reviewing the camera’s manual. Understand the camera’s Auto Exposure Bracketing (AEB) mode (sometimes called “Auto-Exposure Mode” or “Exposure Bracketing) which is the main component in creating HDR images. Bracketing is the term used to describe taking multiple exposures to capture the full spectrum of light in a scene. When you select AEB mode, the camera automatically takes three or more shots with a different exposure for each frame. AEB isn’t necessary, but without it you’ll have to adjust your camera’s exposure manually between each shot, which may increases the chances that your camera will move and increase the likelihood that parts of the scene will move. If your pictures don’t line up, the final HDR image will most likely be unacceptable.

  Metering is one of the more complicated settings on your camera, and one that you need to thoroughly understand. The metering mode is simply how your camera samples light to determine the proper exposure for the image. The camera needs to analyze the light in the scene using different exposure methods. Evaluative Metering generally is your best option. Other metering modes include partial, spot, and center weighted metering. Each mode should be used when required for the scene and can drastically improve your image if you use the proper mode.

- **Lens choice**: You can capture High Dynamic Range images with any lens--telephoto, macro. But by far, ultrawide angle lenses are best for a number of reasons. These lenses take in broad, sweeping angles of view and allow for close focusing to really showcase foreground elements. You can achieve great depth of field, even at medium apertures. Due to the expansive angle of view, you’ve got to be aware of **Keystoning** (Tops of buildings look like they are leaning backwards due to the tilting up of the camera leading to this effect. If the camera is level, then perspective distortion doesn’t occur). When shooting up at a building, make sure the top and bottom windowsills are parallel with the top and bottom of the sensor. Some photographers believe that a 24-70mm lens is the best choice.

- **Tripod**: Since you will be bracketing, you will want to stay as stable as possible between shots. It’s imperative to have a steady platform so all the shots aligned. HDR software generally has a feature which attempts to align the images when the camera has moved between shots, however, the best results are achieved when this feature is not relied upon. Also make sure you have a **good tripod head**.

- **Remote Release**: If you have a remote release for your camera, use it. You can also use the short self-timer. In order to boost the quality of your photographs use a delay for Mirror Lock-Up before every picture is taken. Locking the mirror before taking a picture gives a tripod-based camera the ultimate stability required to take a perfectly sharp photograph. If your camera has automatic exposure bracketing, then use it (this is called AEB on the menus on Canon cameras). Setting AEB to -2/+2 EV is generally a good options but must be increased for high contrast scenes.

- **Triggertrap Mobile**: Triggertrap Mobile utilizes the sensors and processing power of a smartphone or tablet to trigger cameras based on sound (clap, honk etc.), motion, vibration, or location. The app allows for time lapse photography, Bulb Ramping, HDR bracketing and other features. The camera is connected to the smartphone
or tablet using the Triggertrap Mobile Dongle (camera specific). The apps are free and available both for iPhone and Android.

- **Promote® Control**: Promote Control is a remote control device for digital SLR cameras. The Control allows for advanced control of camera functions via USB interface and can accomplish automatic bracketing for up to 45 shots in a row and up to 9.0EV steps between bracketed exposures. By default, the Promote Control takes a "middle" shutter speed as a start, and then takes a number of pictures with the shutter speed stepped under and over the "middle" exposure.

- **Tone-mapping (HDR) Software**: The three most popular HDR software programs are Photomatix (the most popular @ $99), HDR Efex Pro (bundle $149), and Adobe Photoshop. Photomatix is a slider and button-based interface that is a lot less intimidating and more intuitive than the Adobe Photoshop interface. Adobe Photoshop has several downsides including the overall level of control but can process a very natural looking HDR image from a bracketed sequence. Google Nik HDR Efex Pro 2 enables you to create exceptional natural and artistic images. The company’s patented U Point® technology enables precise, selective fine-tuning, simplifying and speeding up the process for creating high dynamic range images. NOTE: HDR Efex Pro is not a stand-alone program and is not compatible with Adobe Photoshop Elements. Photomatix and Adobe Photoshop are stand-alone programs. If you are looking for a free option then Luminance HDR is recommended and is a very capable HDR program. Many professional photographers provide HDR software discounts on their web sites of about 10%. Most of the HDR software companies provide a 30-day free-trial period and it is recommended you try each before buying.

**Taking HDR photos:**

- **Mount your camera on a steady tripod.** It’s highly recommended to use a tripod in order to achieve the highest quality to ensure that the camera does not move as each image is captured. If it is not possible to use a tripod, the camera should be steadied as much as possible. This can be done by leaning against a tree or a wall, or steadying the camera on top of a rock or railing.

- **Set your camera to shoot in raw and set everything to Manual.** Do not set the camera’s white balance to AWB, set the conditions to sunny, cloudy, etc. Use manual exposure mode and select an appropriate aperture for your scene and the lowest ISO setting possible (100 ISO if possible). Turn off your flash. Always keep the aperture the same between the shots, so Aperture Priority mode is appropriate. You do not want to have images with different depths of field; therefore set Manual Focus. It is very important to understand Depth-of Field (DOF), Hyperfocal Distance (HFD) and how to determine the “sweet point” of your lens (2-3 stops down from maximum aperture). When using a Tripod, set Image Stabilization to OFF.

- **Normally you should not use filters:** The one filter that can be used for HDR images is a solid neutral density filter, which is used to get longer exposure times in bright conditions to help blur moving subject(s), like water. Recommended filter is “Singh-Ray Vari-ND,” which allows you to control the degree of darkness by rotating it.

- **Composition is critical.** For Landscape photos consider the following:

  - An off-center subject encourages the eye to move around the scene. Try looking for a single dominant element that can be placed in the frame according to the rule-of-thirds (grid division into even thirds) or the Golden Ratio rule (62/38 division with the intersection if important diagonals). Finding the right viewpoint is very important to achieve a successful landscape composition. Rather than shooting everything from head height, try shooting from high and low viewpoints and move right and left of the dominant feature.

  - Lead-in lines can improve the impact of and add depth to your photos. Although lead-in lines come in many forms, some natural, others man-made, all of them tend to either lead the viewer in or out of the photo or toward a focal point. Some of the most effective lead-in lines start from the bottom edge of the frame and go straight in to center of the photo.

  - If you want to capture the drama of a great scene, you need to move in close and make the most of the foreground — it’s one of the important elements you need to create a dynamic composition. Emphasizing the foreground will help to give your photographs a sense of distance and scale. Images lacking foreground interest can look flat and boring. Features close to the camera look much bigger than those further away.
Forefront also provides a convenient entry point into the composition for the viewer’s eye which then naturally travels up through the scene to the focal point. By placing the camera in a vertical position, more emphasis can be placed on foreground subjects. Foreground interest shouldn’t dominate the composition or be included for the sake of it. — it should complement the view, creating depth.

- **To photograph a high contrast scene**, you need to take several exposures in order to capture information in both the highlights and the shadows of the scene. The exposures taken must properly cover the dynamic range of the scene, especially the shadows to help prevent noise when processing the photos. To determine the exposures requirement, first set your camera metering to Matrix (Nikon) or Evaluative (Canon) to let the camera pick the best exposure for the whole scene. Review your Histogram and try to get the histogram curve as close to the right side as possible (just touching) and check for any highlight clipping. When satisfied with the exposure, note the settings as this will be your middle exposure setting you will use in Manual mode.

- **Setting Exposure Value (EV)**: If you use one-EV steps (e.g., -1, 0, +1 EV), you will need more photos than if you take them in two-EV steps (e.g., -2, 0, +2 EV). It’s recommend shooting in two-EV steps whenever possible. However, sometimes a 1.5EV spacing vs. 2-EV will give you a smoother tonal gradation. An example of one-stop bracket: $-\frac{1}{2}$-sec, 1-sec, +2-sec; two stop bracket (preferred): $-\frac{1}{4}$-sec, 1-sec, +4-sec; three stop bracket: $-\frac{1}{8}$-sec, 1-sec, +8-sec. The full spectrum of exposure stops in minutes and seconds: 4-min, 2-min, 60-sec, 30-sec, 15, 8, 4, 2, 1-sec, $\frac{1}{2}$, $\frac{1}{4}$, 1/8, 1/15, 1/60, 1/125, 1/250, 1/500, 1/1000, 1/2000-sec and etc.

- **High contrast scenes** can be grouped into roughly two types depending on their dynamic range:
  - **Medium dynamic range scene**: Most landscapes and other types of outdoor scenes fall into this category. Three exposures taken in two-EV steps (-2, 0 +2 EV), or five exposures taken in one-EV steps, are usually sufficient for this type of scene.
  - **High dynamic range scene**: A typical example is the interior of a room with a view outside the window on a sunny day. You need to take at least five exposures in two-EV steps (or nine exposures in one-EV steps) to capture this type of scene, but you may need more.

**Shooting directly into the Sun**, you will need to use a very wide bracket sequence, normally ±4 sequence to get a good HDR image. If you center the lens on the sun, lens flare and ghosting will be minimized. Flare is nearly impossible to remove from you images, and it can get strongly accentuated during tone-mapping.

- Most digital cameras offer **Automatic Exposure Bracketing (AEB)**. This enables you to automatically take three or more exposures in a row; one at the proper exposure, one or more underexposed, and one or more overexposed. Consult your camera manual for model-specific instructions for using this setting. Use your camera’s AEB function but only if it allows sufficient exposure increments and number of auto-bracketed frames to cover the dynamic range. Otherwise, you will have to vary the exposure times manually or use a Promote® Control or Triggertrap Mobile device.

- **Shoot frames as quickly** as you can while keeping the camera steady. Watch out for moving objects such as clouds, people or wind moving foliage. Although Photomatix Pro has a built-in function to reduce ghosting artifacts, it is still best if movements are minimal — motion is sometimes difficult to fix in software.

- **Review your photos**: Use your camera’s histogram preview in playback mode. When reviewing the most overexposed photo, the left part (2/3) of the histogram should be empty. Then review the darkest image histogram, the right part of the histogram (1/2) should be completely empty. If the highlight/shadow photos are not correctly exposed, you will need to add another bracket which will require reshooting the sequence.

**Things to avoid:**

- **Ghosts**: Whenever some element in your composition moves between frames, there is a good chance that it will show as a ghost figure, since the tone mapping algorithm will mix a little bit of each image to reach its final result. Software can normally handle ghosting, but it still can be a major problem. Vegetation blowing such as leaves will be nearly impossible to process. HDR is mainly a technique for static subjects.

- **Noise**: HDR processing will generally increase noise, especially in the shadow areas. Use as low an ISO as possible. The best way to reduce noise in a photo is a noise reduction plugin like Topaz DeNoise.
- **Excessive saturation**: Generally speaking, saturation applied by the tone mapping software will give the toned mapped image an artificial look. Use minimal saturation adjustments in the tone-mapping software. You can fix saturation in post processing either in Photoshop or Lightroom.

- **Excessive contrast**: During the tone mapping process you must decide when contrast is excessive. Try and recall how the scene looked and make adjustments accordingly in the tone-mapping software. If you can’t recall the scene, then make sure the image looks natural, not artificial.

- **Halos**: Whenever dark and a bright areas meet in the image (i.e., edges been mountains and sky) most likely you will have a Halo as a result of tone mapping. A Halo is a white glow around high contrast areas. You can reduce Halos by reducing micro-contrast in the tone-mapping software. However, the best way to avoid halos in a photograph is to apply minimal tone-mapping. When you tone map an image, always keep an eye for halos and process the images in such a way that halos do not form.

---

**Initial Processing of HDR Sequence Images in Lightroom**

As in setting up the camera for HDR, you need to treat your image sequence as though it were a single exposure. The same is true for post-processing all the images. *Any adjustments made to an image must be applied to all other images in the sequence.* Be sure to calibrate your monitor before post-processing.

- **Review images**: Review each image and determine if the histogram for the brightest and darkest images are not completely off the ends

- **White Balance**: Although you can make color temperature corrections in the HDR software, it’s best to get the white balance setting correct up-front.

- **Tone Curve and Color Setting**: The goal is to create a set of relatively low-contrast, low-saturation images that are sharp when viewed at 1:1 magnification. Do not make any Basic settings. Set all settings to zero and it’s particularly important to set the Blacks setting to zero. The Parametric and Point Curves should be linear (flat).

- **Sharpening Settings**: Generally, you get best results by pre-sharpening RAW files to the point where small details are discernible but halos are not. However, it is suggested **NOT TO SHARPEN** to avoid introducing unwanted artifacts & noise.

- **Chromatic Aberration Removal**: Under *Lens Correction* tab select *Basic > Enable Profile Correction* and then enable *Remove Chromatic Aberration*. Chromatic aberrations can be removed within the RAW conversion utility of Lightroom, as Lightroom utilizes lens data tailored to the chromatic aberration reduction for your camera and lens combination.

- **Details**: Set the Sharpening amount to zero.

- **Dust Removal**: Dust spots create headaches in HDR images. It’s best to remove spots prior to conversion but can be removed later in post processing. If you drag the black and white point sliders towards the center of the histogram, doing so will reveal dust spots, which can be removed using the spot removal tool. After locating and removing spots, reset the level tool to its default state (linear [flat] tone curve).

- **Synchronize adjustments**: It’s critical that all images are identical with the exception of exposure. Highlight all the photos and depress the SYN C button.
PHOTOMATIX

Open images directly from Lightroom:

Select the files you want to import into Photomatix by holding down the CTRL key and selecting the photos (or clicking on the first photo, holding down the SHIFT key and clicking on the last photo). Then right click one of the photos and select Export > Photomatix. The “Settings for processing exported files” dialog box will open. The dialog options are:

- **Align images**: This is a handy option you can use when you haven’t used a tripod to shoot your images. The option instructs Photomatix to align the images for you. Be sure to check Crop Aligned Images. If you handheld the camera select that box and a slider will be displayed when loading from Photomatix. Use no more than 15% of Maximum shift.

- **Show options to remove ghosts**: If you had moving objects such as people walking in all your exposures, you don’t want the same person to appear in multiple areas of the image. De-ghosting solves this problem. To remove ghosts, you can either:
  - Select an area to de-ghost manually by choosing a location in the final HDR and telling Photomatix to use a region from another image (this is as simple as circling the area and selecting the image you want to get the area from).
  - Have Photomatix automatically take care of de-ghosting for you. For Automatic Deghosting the medium exposure photo is the one selected and highlighted in darker blue. Normally select the base exposure or -1EV photo. Do not select the higher exposure photos since this will introduce more noise.

- **Reduce noise**: Photomatix can take care of noise reduction for you. This option uses a noise reduction algorithm and is recommended when processing RAW files directly into Photomatix. You can also choose to just reduce noise on underexposed images where noise is more prevalent or the entire image. Photomatix does a fair job removing noise; however, Topaz DeNoise is more effective in removing noise.

- **Reduce chromatic aberrations**: Chromatic aberrations, also known as “color fringing” or “purple fringing”, is a common optical problem that occurs when a lens is either unable to bring all wavelengths of color to the same focal plane, and/or when wavelengths of color are focused at different positions in the focal plane. Chromatic aberration is caused by lens dispersion, with different colors of light travelling at different speeds while passing through a lens. As a result, the image can look blurred or have noticeable colored edges (red, green, blue, yellow, purple, and, magenta) especially around objects in high-contrast areas. Select this option to have Photomatix reduce the aberrations for you.

- **Automatically re-import into Lightroom Library**: Note you can select the name when reimporting the image back to Lightroom.

Depress Export button which will open the Deghosting Options window providing you with two deghosting methods:

- **Selective Deghosting Tool**: An adjustable Automatic Deghosting algorithm. The Selective Deghosting Tool enables you to lasso-select the specific areas of the image that require processing to remove ghosting caused by image to image movement of elements in the scene. Photomatix Pro uses the single image that it deems best exposed for the selected area's brightness, as the default deghosting target image. You may change the automatically selected deghosting target image to any other image of your choice, using the tool.
Automatic Deghosting processes the entire image with an automated ghost reduction algorithm. It is useful with scenes with many small changes between images, which are not practical to manually select with the lasso tool. This deghosting method has the disadvantage of potentially degrading image quality, depending upon the nature of the scene, the type of ghosting, the number of source frames, and other factors. When applying Automatic Deghosting, use the lowest setting that successfully de-ghosts the image. If you need high settings to remove ghosts completely, it is recommended that you use the Selective Deghosting Tool instead.

Click OK to apply the deghosting adjustments to the image, or click Cancel to stop merging the images. If you wish to continue working with the current bracketed set, but with no deghosting applied, then set the Automatic Deghosting amount to "0", or make no Selective Deghosting Tool selections, and simply click OK to proceed.

Overview: Adjusting Images Using Tone Mapping or Exposure Fusion — Main Interface

Photomatix Pro provides access to HDR Tone Mapping and Exposure Fusion methods in one interface, with three main sections: Adjustments panel, Preview and thumbnail Presets.

Tone Mapping vs. Exposure Fusion — Basically, tone mapping is going to produce (potentially) more surreal HDR looking images. The program’s algorithms try to produce a perfectly exposed image resulting in a “bell shaped curve” histogram. Exposure fusion will produce more realistic looking images with much darker darks and lighter lights. The histogram will often have clipping on either side, but that can generally be corrected in Photoshop.

The image Preview displays the result of your current settings. The Preview is updated immediately after a setting has been changed and the following controls are provided:
• **Scaling Slider**: Zooms in or out and refreshes the preview from 50% to 150%. The preview is not recalculated but quickly scaled. Each time the Fit box or one of the Magnifier icons is clicked the preview is recalculated and the Zoom Slider resets to 100%. Fit: resizes the preview to fill the available space on the program's main window.

• **Magnifier icons +/−**: Increases or decreases the preview image by 20% and recalculates it at the new size.

• **Preview**: The Preview checkbox quickly toggles between a preview of the image and the "normal" exposure (0 EV) of the set. This is helpful to compare the effects of the image adjustments.

• **Selection Mode**: Checking the selection mode checkbox enables you to select an area of the preview and replace it with one of the source images.

• **Histogram**: This floating window contains four selectable tabs to assist in analyzing the image: Luminance, Red, Green, and Blue. In addition, move the mouse back and forth across the histogram to display Level, Count, and Percentile information. If the histogram is turned off, enable it by selecting 8-bit Histogram from the View menu.

**Tone mapping**:
Photomatix provides a list of presets you can use on the right. If you want to go that route, choose one to have Photomatix apply the preset then click **Save**. Once you click save, you’re done and will be in imported to Lightroom. However, adjusting the photo using the left side panel gives you much better control on how the image will look. First **depress Method Defaults button** to return the setting to their default position.

**“Tone mapping” for the Process and “Details Enhancer” for the Method**:

• **Strength**: Adjusts the look of the image by affecting the degree of contrast and detail. The more you drag this slider to the left, the more natural the image will look. The more to the right, the more surreal looking the image will get. Every image is different so play with this slider to see how your image is affected by it. **Generally take it to maximum strength of 100 for more dramatic look. For more natural look, use 50 – 80.** To reduce Halos move the slider down to about 80.

• **Color Saturation**: Every image is different and has its own need for saturation. Don’t overdo it; a little goes a long way. **Generally keep it at 55 or below. Try doing your color adjustments in Photoshop or Lightroom.**

• **Tone Compression (was called Luminosity)**: Move this slider to the right to boost shadow details. Move it to the left for a more natural look. Moving this slider has the practical effect of “brightening” or “darkening” the image. **Generally move this slider all the way up when you are adjusting the other sliders in sequence.** You can come back and refine the slider later.

• **Detail Contrast**: Controls the amount of contrast applied to details in the image. Think of this as your “grunginess” slider. The more to the right, the grungier the image will look. It will also darken the image a bit. **Generally move this slider all the way up (use the same amount you used with the Tone Compressor slider).**

• **Lighting Adjustments**: This section controls the “HDR” look of the image. You either use the presets by checking the Lighting Effects checkbox or uncheck the checkbox for Lighting Effects to use the slider (which allows for a more natural look). It is best to use the slider and adjust the slider to your liking. You do not want to dark or light of an image. To help remove Halos use a slider value of 1 – 4.
- Never ever (ever) click Surreal+ when the Lighting Effects checkbox is checked. Medium lighting effect is generally a good option. However, try using the Lighting Effects slider to see a range of affects.

**More Options sliders:**

- **Smooth Highlights:** Reduces contrast enhancement in the image’s highlights. Drag this slider to the right if you’re seeing halos in your images. If your highlights are a dull gray, move the slider to the right. *This slider brightens the Highlights. Generally move the slider up to a very low number* (you get more affect if you move the Shadow Smoothness slider in Advance Options).

- **White Point:** Moving this slider to the right increases global contrast. Moving it to the left decreases highlight clipping. This is handy when your clouds look blown out. *Brightens or Darkens your image.*

- **Black Point:** This slider helps set the image’s black point. Moving it to the left reduces shadow clipping. Do not move the White/Black sliders too far.

- **Gamma:** Adjusts mid-tones and has the effect of brightening the image when dragged to the right. Adjust to your liking.

- **Temperature:** Adjusts the color temperature. Moving this slider to the right gives the image a yellower tone (warming) while moving it to the left gives the images a bluer tone (cooler). In HDR most likely move the slider to the right to give the image a warmer look.

**The Advanced Options:**

- **Micro-smoothing:** Smooths the enhancement of small details. Moving this slider to the right can help reduce noise in the sky. Because the software does a great job, generally leave it at 0.

- **Saturation Highlights:** Does exactly what it says: controls color saturation in the highlights. *Generally do not adjust this at this time but later in Photoshop/Lightroom.*

- **Saturation Shadows:** Another slider that does exactly what it says: affects color saturation in the shadows. *Generally do not adjust.*

- **Shadows Smoothness:** Reduces contrast in the shadows. Dragging this slider to the right has the practical effect of decreasing the “brightness” in the shadow areas. *Generally do not adjust. However, if want your eye to go to Highlights then use this adjustment.*

- **Shadows Clipping:** Clips shadows to black. Slide this to the right to make shadow areas black. *Generally do not adjust.*

**Process the image:** When you are satisfied with the adjustments, click on the Apply button located at the bottom of the Adjustments panel.

---

**“Tone mapping” for the Process and “Contrast Optimizer” for the Method — Natural Look:**

The Details Enhancer is what 95% of all photographers will use to produces the distinctive HDR look. But the results can be very extreme and unnatural if you take it too far. For a natural look you should select Tone Mapping for the process and then Contrast Optimizer for the Method. This method has less sliders to help you arrive at a natural looking photo.

- **Strength:** Affects the amount of enhancement given to contrast and detail in the image. A value of 100 gives the greatest enhancement. Moving the slider to the left gives a more natural effect. The default value is 50.

- **Tone Compression:** Alters the dynamic range of the tone mapped image. Moving the slider to the right decreases the dynamic range, brightening the shadows and darkening the highlights. Moving to the left has the opposite effect, giving a more 'natural' look to the image.
• **Lighting Effect**: Controls the prominence of the shadows, affecting the overall look of the image. Moving the slider to the right brightens the shadows, giving a more 'vibrant' or surreal look. A value of zero disables the effect, leaving the shadows unaffected. The default value is 20.

• **White Clip**: Adjusts the amount of highlights clipping. Moving the slider to the right brightens the image and increases global contrast. Moving to the left decreases global contrast and reduces highlights clipping.

• **Black Clip**: Adjusts the amount of shadows clipping. Moving the slider to the right darkens the image and increases global contrast. Moving to the left decreases global contrast and reduces shadows clipping.

• **Midtone**: Adjusts the brightness of the Midtones, which also has an impact on the overall contrast. Moving the slider to the right brightens the midtones and decreases contrast. Moving to the left darkens the midtones and increases contrast.

• **Color Saturation**: Adjusts the color saturation of the image. The greater the saturation, the more intense the color. Setting the slider to its lowest value (-10) produces a grayscale image.

• **Color Temperature**: Adjusts the color temperature of the tone mapped image relative to the temperature of the HDR source image. Moving the slider to the right gives a 'warmer', more yellow-orange colored look. Moving it to the left gives a 'colder' more bluish look. A value of 0 (default) preserves the original color temperature of the HDR source image.

• **360º Image**: Checking this option eliminates the seam between the left and right sides of a panorama viewed in a 360 degree panoramic viewer. This option is intended for a stitched panorama - it should not be used for individual frames of a panorama that have not yet been stitched.

**Contrast Optimizer recommended workflow:** Depress the Method Defaults button which will take you to the Balance preset. Then go to View > 8 bit Histograms to bring up the Histogram dialog box. Then move the White & Black Clip sliders to insure there isn’t any clipping. Next adjust the Tone Compression which brings the Highlights and Shadows towards the middle when you move the slider to the right. Adjust the Tone Compression slider to a point that pleases you. The Lighting Effect slider control local contrast and is the next adjustment to be made. The more you move the Lighting Effect slider to the right, the more of an unnatural look you will obtain. Next move the Strength slider left and right so you can determine the best visual setting. Now adjust the Midtones. Moving the Midtone slider to the left will darken the image. Finally adjust the Color Saturation (don’t overdue) and Color Temperature.

“**Exposure Fusion**” for the Process and “**Fusion/Natural**” for the Method: Exposure Fusion is not HDR but is a processing of bracketing images, which result in a low dynamic range image. It takes the best tonalities from each image in the sequence and combines them to create a single image. The fusing process assigns weights to the pixels of image in the sequence according to luminosity, saturation, and contrast, and then carefully balances the three to make a single image. The best parts of each image are fused together to combine all of the best elements in final image.

**The benefits of using Exposure Fusion:**

- Exposure fusion results in noise reduction (contrary to local tone-mapping which amplifies noise) – this makes it perfect for night and long-exposure “HDR” photos.
- Images have more natural look,
- Images are free of halo artifacts.
- Using exposure fusion can be easier because it has fewer parameters to set.

The adjustment sliders are described below:
• **Strength**: Sets by how much local contrast is accentuated. Moving the slider to the right tends to brighten the shadows and to show more details in the highlights. Moving to the left produces a more 'natural' effect. Usually leave it at 0.0 or move it to the left (negative values) as it tends to produce more natural looking images.

• **Brightness**: Controls the brightness of the fused image by adjusting the influence each of the input photos has on the final result. Moving the slider to the right gives the overexposed photos more influence, resulting in a brighter result. Moving to the left darkens the result by giving the underexposed photos more influence.

• **Shadows Contrast**: Increases the contrast of shadows in the image by darkening the areas of heaviest shadow and brightening the midtones, giving a more realistic effect. Usually move the slider to a value of 10.0 which is the maximum setting. This way you can restore more details in shadows.

• **Local Contrast**: Increases the contrast and sharpness of details in the image. Increasing local contrast may have the side effect of making noise more visible and of creating thin halo effects around strong luminosity edges. Values near the maximum tend to give a surreal look to the image. The default value is 2. Try to keep this value in range 0.0 to 3.0. Larger values might result in a painterly and unnatural look. Value of 2.0 usually works best.

• **White Clip**: Adjusts the amount of highlights clipping. Moving the slider to the right brightens the image and increases global contrast. Moving to the left decreases global contrast and reduces highlights clipping. Use the Histogram to adjust for clipping.

• **Black Clip**: Adjusts the amount of shadows clipping. Moving the slider to the right darkens the image and increases global contrast. Moving to the left decreases global contrast and reduces shadows clipping.

• **Midtone**: Adjusts the brightness of the midtones, which also has an impact on the overall contrast. Moving the slider to the right brightens the midtones and decreases contrast. Moving to the left darkens the midtones and increases contrast. Usually move the slider to the right to give the image depth.

• **Color Saturation**: Adjusts the color saturation of the image. The greater the saturation, the more intense the color. Setting the slider to its lowest value (-10) produces a grayscale image. Usually keep it at 0 and adjust saturation in Photoshop or Lightroom.

• **360˚ Image**: Checking this option eliminates the seam between the left and right sides of a panorama viewed in a 360 degree panoramic viewer. This option is intended for a stitched panorama - it should not be used for individual frames of a panorama that have not yet been stitched.

**Recommended Process/Method for various types of scenes:**

- **Natural looking Landscape images**: Contrast Optimizer or Fusion/Real-Estate
- **Interiors**: Details Enhancer or Fusion/Real-Estate
- **Night images**: Fusion/Natural
- **Portraits**: Tone Compressor

**Update your software:**

- Photomatix doesn’t automatically check for updates. Therefore, you should check frequently that you have the latest update (Help > Check for updates).
- Magenta screen: If you process a RAW image and have a newer camera, the file suffix may be the same but the codex associated with the newer camera will be different causing the entire image to be painted with magenta. If this occurs to you, then download the latest update.
**Black & White HDR photos:** There are three ways to create a Black & White photo:

- Desaturate the photo in Photomatix Pro by setting the *Saturation* slider to 0. If you use Details Enhancer you have to set the processing methods to a minimum value (-10) and set both *Saturation Highlights* and *Saturation Shadows* to 0.

- Convert the photo to grayscale in Photoshop. For the best B&W spectrum you should select **New Adjustment Layer > Gradient Map**. Then on the Gradient Map Properties dialog box depress the down arrow next to the gradient box and select the third gradient from the left on the top row labeled **Black, White**. This techniques will give you the most contrast and “punch” between B&W.

- Use plugins such a **Nik Silver Efex Pro** or **Topaz BW Effects**. Both these plugins do an excellent job.

**Creating HDR Panoramas:**

- When creating HDR panoramas, its bests to use your HDR software to tone map each panoramic image scene first before stitching into a panorama. It is highly recommended to use identical tonemapping adjustments to each scene.

  If you are using Photomatix to tonemap your images, then make the necessary adjustments to your first scene. Next save those adjustment settings as a Preset. When you tonemap the other scenes, apply the Preset to each HDR scene. To expedite the processing, you should use Photomatix Batch Processing where you select all the remaining scene images and Photomatix will process each scene and save the each scene as a HDR image.

- Next stich each HDR series photos using Photoshop by selecting **File > Automate**. The Photomerge dialog box will display, then click on the Browse button and select your HDR photos. Next check **Blend Images Together** and if needed check **Geometric Distortion Correction**. Depress OK and Photoshop will stich each scene together into a panoramic photo. Photomerge will also correct for exposure difference between scenes. You may see a small line where each layer is stitched. The lines will disappear when you flatten the image.

- Most likely you will have transparency along the edges; therefore, you need to either crop the panoramic image or use Content Aware (make selection, then Edit >Fill >Content Aware).

- Finally, **flatten** all the layers so you make adjustments in Photoshop.

**Post Processing:**

After tone-mapping in Photomatix you basically get only a rough draft that can look dull or have the “HDR” look characterized by over saturated colors, strong “haloing” along high contrast edges, and a surreal look. Post processing is a necessary and very important step to correct these errors and fine tune your image. Sometimes portions of the HDR stitched photo are not appealing and these areas can be corrected by blending an original stitched photo using software such as Photoshop and Elements.

You can find a post-processing tutorial on the Redlands Camera Club website which covers many techniques for post-processing HDR images using Adobe Photoshop.

This article was prepared by John Williams for the benefit of Redlands Camera Club members (for instructional purposes only).
HDR (High Dynamic range) using Adobe Photoshop for tone-mapping

<table>
<thead>
<tr>
<th>What is HDR</th>
<th>1</th>
<th>Adobe Photoshop HDR Pro</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>When to use HDR</td>
<td>1</td>
<td>Merge, then save as a 32-bit TIFF</td>
<td>6</td>
</tr>
<tr>
<td>When not to use HDR</td>
<td>2</td>
<td>Adjust directly to Adobe Camera Raw</td>
<td>7</td>
</tr>
<tr>
<td>Equipment/Software needed</td>
<td>2</td>
<td>Tone Mapping</td>
<td>9</td>
</tr>
<tr>
<td>Taking HDR photos</td>
<td>3</td>
<td>Black &amp; White HDR photos</td>
<td>9</td>
</tr>
<tr>
<td>Things to avoid</td>
<td>4</td>
<td>HDR Panoramas</td>
<td>10</td>
</tr>
<tr>
<td>Initial Processing HDR Images (Lightroom)</td>
<td>5</td>
<td>Post Processing</td>
<td>10</td>
</tr>
</tbody>
</table>

**What is HDR?**

HDR is an acronym for **High Dynamic Range** where dynamic range is the ratio of light to dark in a photograph. By using special HDR software, you can see all the light in the final photo that you saw when you were standing on the scene. The human eye can see so much more than a single camera shot since an eye can see about 11 stops of light whereas a camera can only see about 3 stops of light.

Instead of just taking one photo, HDR uses three or more photos (bracketed images), taken at different shutter speeds. You can then use image editing software which dramatically increases the dynamic range of a photograph by merging different exposures of a same scene.

HDR technique has had some very bad rap, especially in the "fine art" community, due to heavy saturation of colors, strong haloes, high contrast between edges and unrealistic/painterly appearance (sometimes called “HDR Look”). The unrealistic look is cause by pushing the tone-mapping and adjusting the detail algorithms to their limits. However, this technique can be very powerful, look perfectly natural and sometimes it is the only way to capture a scene as our eyes see it.

When HDR software initially processes the images, the result can look grungy, artificial and unrealistic. It is important to remember you should never try to obtain the final look of an image in the tone mapping phase, and instead just focus on bringing all the details back from shadows and highlights. Keep contrast low (especially local contrast) and do not add saturation to the image at this stage.

**When to use HDR:**

- **Landscapecs:** Landscape photos usually have a lot of contrast between the sky and land, which is difficult for your camera to deal with in just one photo. With HDR, you can capture the sky's detail without making the land look too dark, and vice versa. Try to keep an eye out for scenes and subjects that have a large, noticeable contrast between light and dark areas to be able to capture all the full dynamic range.

- **Portraits in Sunlight:** Lighting is one of the most important aspects of a good photo, but too much lighting on someone's face—like harsh sunlight—can cause dark shadows, bright glare, and other unflattering characteristics. HDR can even that all out and make your subject look better.

- **Low-Light and Backlit Scenes:** If your photo is looking a little too dark—which often happens if your scene has too much backlight—HDR can brighten up the foreground without washing out the well-lit portions of your photo.

**When not to use HDR:**

- **Photos with Movement:** If any of your subjects are moving (or might move), HDR increases the chance of a blurry photo. Remember, HDR takes at least three photos, so if you’re subject moves between the first and last shot,
your final picture won’t look good. However, some software will allow you to get rid of ghosting or movement by selecting an individual photo and disregarding the moving object.

- **High-Contrast Scenes:** Some photos look better with stark contrast occurs between dark and light parts of the photo. HDR will make this less intense, resulting in a less interesting photo. However, post processing can help resolve this issue.

- **Vivid Colors:** If your scene is too dark or too light, HDR can bring some of the color back. However, if you’re dealing with colors that are already very vivid, HDR can wash vivid colors out.

- If you can easily blend an image using a **Graduated Neutral Density (GND)** filter then HDR may not be a suitable option. These types of filters can extend dynamic range while still maintaining local contrast. GND filters are best suited when shooting darker land with a very bright sky in landscape photography:

**Equipment/Software needed:**

- **A camera:** If you want to become a better photographer you need to be proficient with all the camera’s features. Spend time reviewing the camera’s manual. Understand the camera’s Auto Exposure Bracketing (AEB) mode (sometimes called “Auto-Exposure Mode” or “Exposure Bracketing) which is the main component in creating HDR images. Bracketing is the term used to describe taking multiple exposures to capture the full spectrum of light in a scene. When you select AEB mode, the camera automatically takes three or more shots with a different exposure for each frame. AEB isn’t necessary, but without it you’ll have to adjust your camera’s exposure manually between each shot, which may increases the chances that your camera will move and increase the likelihood that parts of the scene will move. If your pictures don’t line up, the final HDR image will most likely be unacceptable.

Metering is one of the more complicated settings on your camera, and one that you need to thoroughly understand. The metering mode is simply how your camera samples light to determine the proper exposure for the image. The camera needs to analyze the light in the scene using different exposure methods. Evaluative Metering generally is your best option. Other metering modes include partial, spot, and center weighted metering. Each mode should be used when required for the scene and can drastically improve your image if you use the proper mode.

- **Lens choice:** You can capture High Dynamic Range images with any lens—telephoto, macro. But by far, ultrawide angle lenses are best for a number of reasons. These lenses take in broad, sweeping angles of view and allow for close focusing to really showcase foreground elements. You can achieve great depth of field, even at medium apertures. Due to the expansive angle of view, you’ve got to be aware of **Keystoning** (Tops of buildings look like they are leaning backwards due to the tilting up of the camera leading to this effect. If the camera is level, then perspective distortion doesn’t occur). When shooting up at a building, make sure the top and bottom windowsills are parallel with the top and bottom of the sensor. Some photographers believe that a 24-70mm lens is the best choice.

- **Tripod:** Since you will be bracketing, you will want to stay as stable as possible between shots. It’s imperative to have a steady platform so all the shots aligned. HDR software generally has a feature which attempts to align the images when the camera has moved between shots, however, the best results are achieved when this feature is not relied upon. Also make sure you have a **good tripod head**.

- **Remote Release:** If you have a remote release for your camera, use it. You can also use the short self-timer. In order to boost the quality of your photographs use a delay for Mirror Lock-Up before every picture is taken. Locking the mirror before taking a picture gives a tripod-based camera the ultimate stability required to take a perfectly sharp photograph. If your camera has automatic exposure bracketing, then use it (this is called AEB on the menus on Canon cameras). Setting AEB to -2/+2 EV is generally a good option but must be increased for high contrast scenes.

- **Triggertrap Mobile:** Triggertrap Mobile utilizes the sensors and processing power of a smartphone or tablet to trigger cameras based on sound (clap, honk etc.), motion, vibration, or location. The app allows for time lapse photography, Bulb Ramping, HDR bracketing and other features. The camera is connected to the smartphone or tablet using the Triggertrap Mobile Dongle (camera specific). The apps are free and available both for iPhone and Android.
Taking HDR photos:

- **Promote® Control**: Promote Control is a remote control device for digital SLR cameras. The Control allows for advanced control of camera functions via USB interface and can accomplish automatic bracketing for up to 45 shots in a row and up to 9.0EV steps between bracketed exposures. By default, the Promote Control takes a "middle" shutter speed as a start, and then takes a number of pictures with the shutter speed stepped under and over the "middle" exposure.

- **Tone-mapping (HDR) Software**: The three most popular HDR software programs are Photomatix (the most popular @ $99), HDR Efex Pro (bundle $149), and Adobe Photoshop. Photomatix is a slider and button-based interface that is a lot less intimidating and more intuitive than the Adobe Photoshop interface. Adobe Photoshop has several downsides including the overall level of control but can process a very natural looking HDR image from a bracketed sequence. Google Nik HDR Efex Pro 2 enables you to create exceptional natural and artistic images. The company’s patented U Point® technology enables precise, selective fine-tuning, simplifying and speeding up the process for creating high dynamic range images. NOTE: HDR Efex Pro is not a stand-alone program and is not compatible with Adobe Photoshop Elements. Photomatix and Adobe Photoshop are stand-alone programs. If you are looking for a free option then Luminance HDR is recommended and is a very capable HDR program. Many professional photographers provide HDR software discounts on their web sites of about 10%. Most of the HDR software companies provide a 30-day free-trial period and it is recommended you try each before buying.

### Taking HDR photos:

- **Mount your camera on a steady tripod.** It’s highly recommended to use a Tripod in order to achieve the highest quality to ensure that the camera does not move as each image is captured. If it is not possible to use a tripod, the camera should be steadied as much as possible. This can be done by leaning against a tree or a wall, or steadying the camera on top of a rock or railing.

- **Set your camera to shoot in raw and set everything to Manual.** Do not set the camera’s white balance to AWB, set the conditions to sunny, cloudy, etc. Use manual exposure mode and select an appropriate aperture for your scene and the lowest ISO setting possible (100 ISO if possible). Turn off your flash. Always keep the aperture the same between the shots, so Aperture Priority mode is appropriate. You do not want to have images with different depths of field; therefore set Manual Focus. It is very important to understand Depth-of Field (DOF), Hyperfocal Distance (HFD) and how to determine the “sweet point” of your lens (2-3 stops down from maximum aperture). When using a Tripod, set Image Stabilization to OFF.

- **Normally you should not use filters:** The one filter that can be used for HDR images is a solid neutral density filter, which is used to get longer exposure times in bright conditions to help blur moving subject(s), like water. Recommended filter is “Singh-Ray Vari-ND,” which allows you to control the degree of darkness by rotating it.

- **Composition is critical.** For Landscape photos consider the following:
  - An off-center subject encourages the eye to move around the scene. Try looking for a single dominant element that can be placed in the frame according to the rule-of-thirds (grid division into even thirds) or the Golden Ratio rule (62/38 division with the intersection if important diagonals). Finding the right viewpoint is very important to achieve a successful landscape composition. Rather than shooting everything from head height, try shooting from high and low viewpoints and move right and left of the dominant feature.
  - Lead-in lines can improve the impact of and add depth to your photos. Although lead-in lines come in many forms, some natural, others man-made, all of them tend to either lead the viewer in or out of the photo or toward a focal point. Some of the most effective lead-in lines start from the bottom edge of the frame and go straight in to center of the photo.
  - If you want to capture the drama of a great scene, you need to move in close and make the most of the foreground — it’s one of the important elements you need to create a dynamic composition. Emphasizing the foreground will help to give your photographs a sense of distance and scale. Images lacking foreground interest can look flat and boring. Features close to the camera look much bigger than those further away. Foreground also provides a convenient entry point into the composition for the viewer’s eye which then naturally travels up through the scene to the focal point. By placing the camera in a vertical position, more
emphasize can be placed on foreground subjects. Foreground interest shouldn’t dominate the composition or be included for the sake of it. — it should complement the view, creating depth.

- **To photograph a high contrast scene**, you need to take several exposures in order to capture information in both the highlights and the shadows of the scene. The exposures taken must properly cover the dynamic range of the scene, especially the shadows to help prevent noise when processing the photos. To determine the exposures requirement, first set your camera metering to Matrix (Nikon) or Evaluative (Canon) to let the camera pick the best exposure for the whole scene. Review your histogram and try to get the histogram curve as close to the right side as possible (just touching) and check for any highlight clipping. When satisfied with the exposure, note the settings as this will be your middle exposure setting you will use in Manual mode.

- **Setting Exposure Value (EV)**: If you use one-EV steps (e.g., -1, 0, +1 EV), you will need more photos than if you take them in two-EV steps (e.g., -2, 0, +2 EV). It’s recommend shooting in two-EV steps whenever possible. However, sometimes a 1.5EV spacing vs. 2-EV will give you a smoother tonal gradation. An example of one-stop bracket: -1/2, 1, 2, +2; two stop bracket (preferred): -1, 1, +2; five stop bracket: -1, 4, 2, 1, 2, +2. The **full spectrum of exposure stops in minutes and seconds**: 4-min, 2-min, 60-sec, 30-sec, 15, 8, 4, 2, 1-sec, ½, ¼, 1/8, 1/15, 1/60, 1/125, 1/250, 1/500, 1/1000, 1/2000-sec and etc.

- **High contrast scenes** can be grouped into roughly two types depending on their dynamic range:
  - **Medium dynamic range scene**: Most landscapes and other types of outdoor scenes fall into this category. Three exposures taken in two-EV steps (. -2, 0 +2 EV), or five exposures taken in one-EV steps, are usually sufficient for this type of scene.
  - **High dynamic range scene**: A typical example is the interior of a room with a view outside the window on a sunny day. You need to take at least five exposures in two-EV steps (or nine exposures in one-EV steps) to capture this type of scene, but you may need more.

**Shooting directly into the Sun**, you will need to use a very wide bracket sequence, normally ±4 sequence to get a good HDR image. If you center the lens on the sun, lens flare and ghosting will be minimized. Flare is nearly impossible to remove from you images, and it can get strongly accentuated during tone-mapping.

- Most digital cameras offer Automatic Exposure Bracketing (AEB). This enables you to automatically take three or more exposures in a row; one at the proper exposure, one or more underexposed, and one or more overexposed. Consult your camera manual for model-specific instructions for using this setting. Use your camera’s AEB function but only if it allows sufficient exposure increments and number of auto-bracketed frames to cover the dynamic range. Otherwise, you will have to vary the exposure times manually or use a Promote® Control or Triggertrap Mobile device.

- **Shoot frames as quickly** as you can while keeping the camera steady. Watch out for moving objects such as clouds, people or wind moving foliage. Although Photomatix Pro has a built-in function to reduce ghosting artifacts, it is still best if movements are minimal — motion is sometimes difficult to fix in software.

- **Review your photos**: Use your camera’s histogram preview in playback mode. When reviewing the most overexposed photo, the left part (2/3) of the histogram should be empty. Then review the darkest image histogram, the right part of the histogram (1/2) should be completely empty. If the highlight/shadow photos are not correctly exposed, you will need to add another bracket which will require reshooting the sequence.

**Things to avoid:**

- **Ghosts**: Whenever some element in your composition moves between frames, there is a good chance that it will show as a ghost figure, since the tone mapping algorithm will mix a little bit of each image to reach its final result. Software can normally handle ghosting, but it still can be a major problem. Vegetation blowing such as leaves will be nearly impossible to process. HDR is mainly a technique for static subjects.

- **Noise**: HDR processing will generally increase noise, especially in the shadow areas. Use as low an ISO as possible. The best way to reduce noise in a photo is a noise reduction plugin like Topaz DeNoise.
- **Excessive saturation:** Generally speaking, saturation applied by the tone mapping software will give the toned mapped image an artificial look. Use minimal saturation adjustments in the tone-mapping software. You can fix saturation in post processing either in Photoshop or Lightroom.

- **Excessive contrast:** During the tone mapping process you must decide when contrast is excessive. Try and recall how the scene looked and make adjustments accordingly in the tone-mapping software. If you can’t recall the scene, then make sure the image looks natural, not artificial.

- **Halos:** Whenever dark and a bright areas meet in the image (i.e., edges been mountains and sky) most likely you will have a Halo as a result of tone mapping. A Halo is a white glow around high contrast areas. You can reduce Halos by reducing micro-contrast in the tone-mapping software. However, the best way to avoid halos in a photograph is to apply minimal tone-mapping. When you tone map an image, always keep an eye for halos and process the images in such a way that halos do not form.

---

**Initial Processing of HDR Sequence Images in Lightroom**

As in setting up the camera for HDR, you need to treat your image sequence as though it were a single exposure. The same is true for post-processing all the images. *Any adjustments made to an image must be applied to all other images in the sequence.* Be sure to calibrate your monitor before post-processing.

- **Review images:** Review each image and determine if the histogram for the brightest and darkest images are not completely off the ends.

- **White Balance:** Although you can make color temperature corrections in the HDR software, it’s best to get the white balance setting correct up-front.

- **Tone Curve and Color Setting:** The goal is to create a set of relatively low-contrast, low-saturation images that are sharp when viewed at 1:1 magnification. Do not make any Basic settings. Set all settings to zero and it’s particularly important to set the Blacks setting to zero. The Parametric and Point Curves should be linear (flat).

- **Sharpening Settings:** Generally, you get best results by pre-sharpening RAW files to the point where small details are discernible but halos are not. However, it is suggested **NOT TO SHAPREN** to avoid introducing unwanted artifacts & noise.

- **Chromatic Aberration Removal:** Under *Lens Correction* tab select **Basic > Enable Profile Correction** and then enable *Remove Chromatic Aberration*. Chromatic aberrations can be removed within the RAW conversion utility of Lightroom, as Lightroom utilizes lens data tailored to the chromatic aberration reduction for your camera and lens combination.

- **Details:** Set the Sharpening amount to zero.

- **Dust Removal:** Dust spots create headaches in HDR images. It’s best to remove spots prior to conversion but can be removed later in post processing. If you drag the black and white point sliders towards the center of the histogram, doing so will reveal dust spots, which can be removed using the spot removal tool. After locating and removing spots, reset the level tool to its default state (linear [flat] tone curve).

- **Synchronize adjustments:** It’s critical that all images are identical with the exception of exposure. Highlight all the photos and depress the SYNC button.
Adobe Photoshop HDR PRO

Merge the photos together into a single 32 bit image.

In Lightroom select all the images you are going to merge. Right click and then choose Edit In >Merge to HDR Pro in Photoshop. The following merged dialog box will open:

Your images will now be merged into a single photo. You can turn off individual photos by unchecking their boxes on the bottom left filmstrip. If you get some blurring caused by camera shake in the longest exposure, you may want to turn off that photo. If there is ghosting because of movement, click the box: Remove Ghosts

Three ways to adjust the Merge image: (1) Save the file as a TIFF and then import to Lightroom or Photoshop to adjust. (2) From the Merge dialog box go directly to Adobe Camera Raw in Photoshop. (3) Tone process the image using the controls in the Merge dialog box. The first two ways will allow you to get a much more natural and clean images without halos and excessive noise. If you want a more “HDR Look” then you can use plugins such as Nik Color Efex or Topaz Adjust.

1. After Merge, save the image as a 32-bit TIFF.

- After the HDR images are merged, set the Mode to 32 bit. A smaller dialog box will open with a Histogram and only one slider (white). You can view the available tones by sliding the White Point slider. Note, this slider doesn't change the image; it is there for you to examine the range of tones, because a monitor is incapable of displaying all the tonal detail in a 32-bit file all at once.

- If you suspect ghosting, then check the “Remove ghosts” box. Make sure the box next to “Complete Toning in Adobe Camera Raw (ACR) is unchecked.

- Then at the bottom of the right panel click OK. The merged photo will be placed in Photoshop as a background Layer.
• Save the image as a 32-bit TIFF file (File > Save as). When the Save Dialog box opens make sure you select 32-bits and then close the image in Photoshop.

• Then open the TIFF file in Lightroom or Photoshop. You will have all the adjustment tools available for processing your image, including Adobe Camera Raw (ACR). NOTE: Be sure to select EDIT > Preferences > Camera Raw and then select for TIFF files “Automatically open all supported TIFF files” to bring up the ACR dialog box when the image opens.

• Make your ACR adjustments to the 32-Bit file and then convert the image to a 16-Bits file by choosing Edit > Mode > 16 Bits/Channel. Then save the 16-bit file. Open the 16-bit TIFF image and continue to make ACR adjustments again and other adjustments you deem necessary.

**TIP FOR SAVING 32-bit FILE:** At the bottom of the ACR window is a blue underlined file information line. Click on it and you will get the Workflow Options dialog box. Select 16-bit (Depth) and at the bottom left of dialog box check the box “Open in Photoshop as a Smart Object.” Click OK and then click on the ACR “Open Object” button.

Your Layer panel will show the thumbnail image as a Smart Object. If you use a Filter like Nik or Topaz then if you go back to adjusting in Adobe Camera Raw (by double-clicking the thumbnail image), the image will be updated with the ACR adjustment and the Smart Filter will be reapplied click the ACR OK dialog button.

2. **Open Adobe Camera Raw (ACR) directly from Merge dialog box:** There is a new feature in Adobe Photoshop CC that allows you to import the merged image directly into Adobe Camera Raw. When working in ACR, you have more direct and intuitive control over highlights, shadows and overall exposure.

• Once opened into HDR Pro (merged dialog box), set the Mode to 32 bit. A histogram will be display with an option to “Complete Toning in Adobe Camera Raw”.

• If you believe that objects have moved in your shots (i.e., foliage, leaves, etc.) then check the option to ‘Remove ghosts’. (The Histogram is greyed out once this box is checked).

• Next make sure the “Complete Toning in Adobe Camera Raw” box is checked (the histogram will be grayed out once this box is checked). Enabling this option, changes the “OK” button at the bottom of the right panel to “Tone in ACR”. Click on the “Tone in ACR” button which tells Photoshop to convert the 32 bit HDR layer into a Smart Object and automatically apply Camera Raw as a Smart Filter.

**NOTE:** You may notice right away that some of the usual ACR controls available in single image workflows are not available here. For example, the Crop & Straighten tools are not available, nor are Lens Profile Corrections. Therefore, it’s usually best to apply Crop and Lens Profile Correction in Lightroom and then SYNC the images prior to opening the files in Merge to HDR Pro.

• When the image is returned to Photoshop as a 32bit image you will notice that the image has been wrapped automatically into a Smart Object/Filter and a white revealing mask has been applied.
Because you are working with a smart object, not only can you double click the layer thumbnail to re-edit the Camera Raw options, but you can also use the Smart Filter mask to selectively show and hide the effect and change the Blend Mode and Opacity of the filter. Also, the Camera Raw Filter can be re-opened by double clicking (or using a right click) on the Camera Raw Filter text. The eye icon next to the Camera Raw Filter text will cause the filter to be re-rendered, as opposed to being turned on/off

Interesting effects can be applied to the image by changing the way that the Camera Raw Filter blends with the smart object image by selecting the ‘Blending Options (Camera Raw Filter)’ by double clicking on the double arrow icon next to word Camera Raw Filter in the Layer panel and choosing Luminosity blending mode and 80% opacity. This process should save you a lot of steps in the HDR process within Photoshop CC and enable you to get the maximum tonal range out of your 32-bit tonal range.

Note: Only the following Blend Modes are available when using Camera Raw as a Smart Filter: Normal, Dissolve, Darken, Multiply, Darker Color, Lighten, Linear Dodge (add), Lighter Color, Difference, Subtract, Divide, Hue, Saturation Color and Luminosity. Many functions are not available (grayed out) when working on a 32-bit image.

After you adjust the image in ACR, you can use several of Photoshop’s adjustments. Depress the ‘Create new fill or adjustment layer’ icon and select one of the adjustments. One of the most important adjustments is Exposure.

Convert the 32-bit HDR image to a 16bit or 8bit tonal range:

- The 32bit image is created using floating point numbers and is able to store an extremely large tonal range; therefore, it contains information that is outside of the normal range of the eye or camera’s sensor. If you want to convert to a lower bit depth you will need to consider that actual tonal range will become compressed.

- To convert select Image > Mode > 8 bit or 16 bit. If you have a smart filter applied to the HDR image, Photoshop will inform you some filters may not work correctly on the converted bit depth.

- Press OK.

- Photoshop will then tell you that HDR images may not look the same once you perform the bit depth conversion.

- If you choose Don’t Merge, Photoshop will try to calculate the tonal ranges changes that are need for the conversion. Once the conversion has completed the image may not look as it previously did in 32 bit mode.

- If you choose Merge, then Photoshop will show a dialog box that will allow you to manually choose the areas of the tonal range that will be changed. You will need to experiment with the output choices. When you convert to 16-bit, change the method to “Local Adaption.” This is the most flexible method and probably the one which is most used by photographers. Unlike the other three methods, this one changes how much Photoshop brightens or darkens regions on a per-pixel basis.
3. Tone-mapping in the Merge dialog box:

- After the images are loaded into the HDR Toning Dialog box, select 16-bit (or 8-bit). All the tone controls will become visible when you change Method to Local Adaption. With local Adaption, you get some advanced Tone Mapping sliders and you can adjust the curves.

- **Gamma/exposure:** To tone-map, set the gamma first, and then adjust the exposure. If you want an image with lots of contrast, lower the gamma. For less contrast raise the gamma. Finally, adjust the exposure to get the desired brightness.

- **Edge Glow:** Once you’re happy with the adjustments, adjust the radius and strength sliders to make sure there are no halos in the photo.
  - Radius controls the mask blur.
  - Strength decides how strong to apply the effect.

- **Tone and Detail:**
  - Gamma: This is where you control the contrast. Extremes are washed out or super punchy.
  - Exposure: Controls the overall brightness.
  - Detail: This sharpens or softens the appearance.

- **Advanced:**
  - Shadow: Opens up details in darkest parts of the photograph.
  - Highlight: Recovers detail in the brightest areas of the photograph.
  - Vibrance: This makes the photo more colorful without over saturating areas that are already colorful. Vibrance tends to enhance colors that are underrepresented in an image, while leaving colors that are already very prominent alone. It also tends not to over process flesh tones.
  - Saturation: Increases or decreases the overall (global) amount of color. Be careful not to over saturate the colors.

- **Curves:** The use of curves is optional. If you’d like to adjust the overall contrast in the image, you can do this in the Curve tab. Simply click on the curve to add a point, and then drag that point to increase/ decrease the contrast as needed. Adjust curves as you would normally but don’t be afraid to clip the histogram a little. You can clip because you’re working with a larger dynamic range. Bring out the detail in the image, but don’t forget to put some shadow in or the image will look washed out and fake.

Click ok to convert.

**Black & White HDR photos:** There are three ways to create a Black & White photo:

- Desaturate the photo in Photomatix Pro by setting the Saturation slider to 0. If you use Details Enhancer you have to set the processing methods to a minimum value (-10) and set that both Saturation Highlights and Saturation Shadows to 0.

- Convert the photo to grayscale in Photoshop. For the best B&W spectrum you should select **New Adjustment Layer > Gradient Map.** Then on the Gradient Map Properties dialog box depress the down arrow next to the gradient box and select...
the third gradient from the left on the top row labeled **Black, White**. This techniques will give you the most contrast and “punch” between B&W.

- Use plugins such a **Nik Silver Efex Pro** or **Topaz BW Effects**. Both these plugins do an excellent job.

### Creating HDR Panoramas:

- When creating HDR panoramas, its bests to use your HDR software to tone map each panoramic image scene first before stitching into a panorama. It is highly recommended to use identical tonemapping adjustments to each scene.

  If you are using Photomatix to tonemap your images, then make the necessary adjustments to your first scene. Next save those adjustment settings as a Preset. When you tonemap the other scenes, apply the Preset to each HDR scene. To expedite the processing, you should use Photomatix Batch Processing where you select all the remaining scene images and Photomatix will process each scene and save the each scene as a HDR image.

- Next stich each HDR series photos using Photoshop by selecting **File > Automate**. The Photomerge dialog box will display, then click on the Browse button and select your HDR photos. Next check **Blend Images Together** and if needed check **Geometric Distortion Correction**. Depress OK and Photoshop will stich each scene together into a panoramic photo. Photomerge will also correct for exposure difference between scenes. You may see a small line where each layer is stitched. The lines will disappear when you flatten the image.

- Most likely you will have transparency along the edges; therefore, you need to either crop the panoramic image or use Content Aware (make selection, then Edit >Fill >Content Aware).

- Finally, **flatten** all the layers so you make adjustments in Photoshop.

### Post Processing:

After tone-mapping in Photomatix you basically get only a rough draft that can look dull or have the “HDR” look characterized by over saturated colors, strong “haloing” along high contrast edges, and a surreal look. Post processing is a necessary and very important step to correct these errors and fine tune your image. Sometimes portions of the HDR stitched photo are not appealing and these areas can be corrected by blending an original stitched photo using software such as Photoshop and Elements.

You can find a post-processing tutorial on the Redlands Camera Club website which covers many techniques for post-processing HDR images using Adobe Photoshop.

---

This article was prepared by John Williams for the benefit of Redlands Camera Club members (for instructional purposes only).